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New Features

The following new features have been added in version 12.5 of TIBCO Spotfire® Analyst.
For details about new Spotfire features, see What's New in TIBCO Spotfire in the TIBCO Community.

Key Version Summary

SPOT-1791 12.5.0 Faster Python data functions

The Python data function execution speed has been significantly improved, leading to
more efficient workflows and better productivity.

Beyond generic improvements, run-length encoding (RLE) compression is now
available also for Python data functions, which reduces the size of data and therefore
reduces network latency.

In the cases where RLE compression is not desired, an administrator can disable this
feature via a group preference (Pyt honSer vi ceUseRunLengt hEncodi ng), using the
Administration Manager.

SPOT-1842 12.5.0 Improved usability for data view parameters in external actions

During configuration of a data view parameter, you will now see information about
any existing row limits directly in the Configure action flyout. When triggering an
action, you will be prevented from running it if the number of rows are not within the
specified row limit range. Additionally, an action that works on marked data can be
made inactive until some data is marked.

SPOT-2161 12.5.0 New Markings panel for better overview and management of markings

The new Markings panel enables adding, editing, and removing markings both in the
installed client and the web client. In the Markings panel, you can quickly view the
number of visualizations that are using or are limited by a specific marking. You can
also jump directly to a visualization from the panel.

Markings in Spotfire are visual representations of user-selected data in visualizations,
providing a powerful way to interact with, and explore, data. Markings can be used to
perform a variety of operations in Spotfire, such as highlighting selected data points,
filtering data, and linking multiple visualizations together.

To open the Markings panel, select View > Markings on the menu bar.

SPOT-3078 12.5.0 Save items as favorites in the library

You can now mark individual items (for example, files, folders, information links, data
connections, etc.) as favorites in the Spotfire library.

e You can add and remove an item as a favorite by clicking the "star" icon next to the
item, in the Files and data flyout or the web view of the library.

e You can quickly access your favorite items by clicking Favorites in the Files and data
flyout.

e The favorite item list is private, only visible to the person that created it.

e The favorites counter, next to the favorites icon, shows the number of users that
currently have that item as a favorite.

o The favorites counter is visible to all users that have access to the View favorite
counter license feature.

Note: The Spotfire Server administrator can switch off the favorites feature for the
entire Spotfire environment, or hide the favorites counter from all users except for
library administrators (or another group) using the View favorite counter license feature
(under the TIBCO Spotfire Consumer license).
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Key

SPOT-3098

Version

12.5.0

Summary

Data tables overview in data canvas

If you have an analyst or business author role, and you have access to the Manage
Data Tables license feature, you can now view and manage data tables, data tables
properties, and column properties from the data canvas, both in the installed client
and the web client.

You reach the new overview by opening the data canvas sidebar and clicking on the
Data tables header. Click the various tabs in the overview to go to the corresponding
section. The data table properties and the column properties views let you view and
create new properties, and you can edit default values where applicable.

SPOT-3123

12.5.0

Connector for TIBCO Data Virtualization supports BOOLEAN

You can now access BOOLEAN type data with the connector for TIBCO Data
Virtualization.

TS-72317

12.5.0

Prompt for username and password in Information Services data sources

In Information Designer, you can now create data sources where end users must log
in with their credentials both to access data, and to create a new information link. To
achieve this, select the User authentication check box for the data source, and do not
input the username and password.

TSDC-7136

12.5.0

Control metadata loading for Google BigQuery data connections

In the Administration Manager, there is a new preference setting, Connectors >

Googl e BigQuery > ListAllProjects. With this preference, you can control if you
can see and select data from all your projects, or only the selected billing project, when
you create or edit a Google BigQuery data connection. By setting Li st Al | Proj ects to
Fal se, you might be able to reduce the time it takes to load metadata when you open
the Views in Connection dialog, especially if you have access to data in many projects.

TSDC-7179

12.5.0

Command timeout for SAP HANA connections

When you create or edit an SAP HANA data connection, you can now adjust the
Command timeout.
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Changes in Functionality

The following are important changes in functionality in version 12.5 of TIBCO Spotfire® Analyst.

Key Version Summary

SPOT-2058 12.5.0 Skia replaces System.Drawing as the default graphics backend

Spotfire now uses Skia as the default graphics backend. Skia is a modern graphics
library that offers performance and cross-platform compatibility advantages over
System.Drawing, facilitating consistent rendering across different devices and
operating systems.

The transition from System.Drawing to Skia affects only the rendering engine and
therefore should not impact existing analyses, functionality, or user experience.

However, it is still possible to switch back to System.Drawing, both for installed
Spotfire clients and for web clients, if you encounter any issues with Skia.

Note that if you use TIBCO Spotfire Qualification, the compare tool will not report
any differences between the gold standard and the comparison exports, however, you
might notice slight visual differences between the analyses in Spotfire and the exports.

TS-67487 12.5.0 Changes to default logging

Logging is now enabled at WARN level by default. When it is changed (under Help
> Support diagnostics and logging > Logging) to INFO or DEBUG, a useful set of
performance counters will be logged to Per f or manceCount er Log. t xt in the Log
folder. The logging configuration will always be persisted to Spot fi re. Dxp. Gen.

| og4net . confi g. DO. NOT. EDI T in the Set t i ngs folder.
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Deprecated and Removed Features

Deprecated features

No features are deprecated as of this release of TIBCO Spotfire® Analyst.

Removed features

No features have been removed in this release of TIBCO Spotfire® Analyst.
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Third Party Software Updates

The following third party software (TPS) components have been added or updated in version 12.5 of
TIBCO Spotfire® Analyst.

Key Version Summary
TS-72522 12.5.0 Bouncy Castle updated to 2.2.1
T5-72299 12.5.0 Chromium Embedded Framework updated to 112.2.7
TS-72314 12.5.0 Magick NET-Q16-AnyCPU updated to 13.0.1
TS-72311 12.5.0 Microsoft. AspNetCore. Authentication.Certificate updated to 6.0.16
TS-72312 12.5.0 Microsoft.AspNetCore.JsonPatch updated to 6.0.16
TS-72313 12.5.0 Microsoft. AspNetCore.Mvc.NewtonsoftJson updated to 6.0.16
TS-72337 12.5.0 Newtonsoft.Json updated to 13.0.3
TS-72325 12.5.0 System.ServiceModel.Http updated to 4.10.2
TS-72326 12.5.0 System.ServiceModel.Primitives updated to 4.10.2
TSDC-7180 12.5.0 TIBCO Data Virtualization ADO.NET Driver updated to 8.7.0
TS-72638 12.5.0 The TIBCO Enterprise Runtime for R bundled engine is updated to 6.0.3.
TS-72338 12.5.0 jQuery updated to 3.6.4
TS-72323 12.5.0 preact updated to 10.13.2
TS-72324 12.5.0 system.management updated to 6.0.1
TS-72356 12.5.0 system.private.servicemodel updated to 4.10.2
TS-72753 12.5.0
e Updated the bundled Python interpreter to version 3.10.11.
e Updated the following Python packages:

—  NumPy updated to 1.24.3

—  Pandas updated to 2.0.1

—  pip updated to 23.1.2

—  pytz and tzdata updated to 2023.3

—  setuptools updated to 67.7.2

—  spotfire updated to 2.0.1

—  wheel updated to 0.40.0
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Closed Issues

The table lists important closed issues in version 12.5 of TIBCO Spotfire® Analyst.

Key Version Summary

TS-72058 12.5.0 When the Japanese keyboard is used, the Input Method Editor (IME) pop-up menu is
sometimes opened at the top left corner of the screen and not where the cursor is.

T5-72140 12.5.0 In some situations, the map projection is not correctly loaded when an analysis
containing map chart visualizations is opened.

TS-72177 12.5.0 When two input parameters in a data function have the same name but use different
casing, the wrong preview value is sometimes shown in the configuration flyout when
you are adding or editing the data function.

T5-72178 12.5.0 Some drop-down lists do not close if scrolling is done outside the drop-down list.

TS-72238 12.5.0 If you save an analysis that contains an information link with unsaved changes,
you might not be able to open the analysis as a user without the license to create
information links.

TS-72271 12.5.0 Connecting to Data Streams using the setting "No authentication" does not work and
results in a Nul | Ref er enceExcept i on.

TS-72372 1250 The Add method of Vi sual i zati onFi | t eri ngCol | ecti on allows using the API to add
the same instance of a filter or marking multiple times. This might cause Spotfire to
close unexpectedly when too many instances are added.

TS-72379 12.5.0 Spotfire closes unexpectedly if a text area is edited when it contains an i ng element but
no sr ¢ attribute.

TS-72400 12.5.0 Tabs for hidden pages are sometimes not visible when an analysis is opened from the
library.

TS-72485 12.5.0 The tooltip on the Hide columns that are not valid for Replace Value check box is
misleading.

TS-72517 12.5.0 If an analysis file is saved containing a text area with a calculated value or an icon, the

analysis cannot be opened in an earlier version of Spotfire.

TS-72676 12.5.0 Web-based custom visualizations can steal keyboard focus from the Filters panel.

TS-72736 12.5.0 When Ratio settings other than 1:1 are used in map charts, labels are missing in feature
layers.

T5-72777 12.5.0 When changing the formatting for multiple columns at the same time (using multi-

select) in the Column properties dialog, multiple events are emitted.

TSDC-7101 12.5.0 When you access data with the data connector for Amazon Redshift, you cannot see
columns for external data tables (such as Redshift Spectrum tables) in the Views in
Connection dialog.
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Key Version Summary

TSDC-7165 12.5.0 When you access data with the connector for Microsoft SharePoint Online, it is not
possible to import a calculated Dat e column, where the date has a custom format that
does not match the expected format in Spotfire.

TSDC-7166 12.5.0 It is not possible to join or compare data from a Dat e column imported from a
Microsoft SharePoint Online data connection, with a Dat e column from any other data
source, because Dat e columns in Microsoft SharePoint Online have a time part.
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Known Issues

The following are known issues in version 12.5 of TIBCO Spotfire® Analyst.

Key Version Summary

TS-62137 12.5.0 Package installation precedence rules

Python packages that are installed by the Administrator (through an SPK) take
precedence over packages installed using the Python Tools from the Spotfire Analyst
Tools menu. If users attempt to update a package previously installed by an SPK, then
the package update is installed, but the update is ignored.

TS-67478 12.5.0 Data connections created with Amazon Redshift in Spotfire 11.5.0 incompatible
with earlier versions

Data connections created in Spotfire versions 11.5.0 and later using the TIBCO Spotfire
Connector for Amazon Redshift cannot be opened in versions earlier than 11.5.0.

Workaround: Refresh the schema and perform a table repair for the Data Connection
view.

TS-67656 12.5.0 "Unable to write data" error message

Error message "Unable to wite data to the transport connection: An
establ i shed connection was aborted by the software in your host
machi ne. "

If you see this error, then the data being uploaded to the service is too large. When

a Spotfire data function is run, it sends the relevant data from Spotfire to the service
for processing. The service has a file size upload limit, the default of which is 100 MB.
When a data function is run with data that exceeds this limit, the service returns the
error.

An administrator can change this upload limit if needed by creating a custom
configuration. For more information, see the topic "File size upload limit" in the service
Installation and Administration guide.

If users see this error message, the administrator can consider creating a custom
configuration that increases the limits for both of the following properties:

e spring.servlet.nultipart.max-file-size:The total file size for upload
cannot exceed the value for this setting.

e spring.servlet.multipart.mx-request-size: The total request size for a
multipart file upload cannot exceed the value for this setting.

Note: At a certain point, the Java Heap size fails to handle very large files. The
threshold for this behavior is dependent on the amount of RAM the service node has.
When the Java Heap Size is exceeded, the following error message is displayed.

Error from Renpte Service: Internal Server Error (500) - java.lang.
Qut O MenoryError: Java heap space
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Key Version Summary

T5-69770 12.5.0 Empty String columns in exported SBDF causes an error

If you export an SBDF from Python (for example, as outputs for a data function), and
your output contains an empty column, then you can encounter the following error:

spotfire. sbdf. SBDFError: cannot determine type for colum 'EnptyString'
; all values are missing

This error occurs because the Spotfire data function environment cannot determine
the proper Spotfire type to export the data as if all values in the column are missing (in
other words, Python's None, NumPy's nan, or Panda's NA or NaT values). {{}}

Workaround:

To resolve this issue, edit your data function to use the helper function set _spotfire_
types.

Exanpl e

import pandas as pd

inmport spotfire

df = pd. Dat aFrane(i np)

spotfire.set_spotfire_types(df, {'EnptyString': 'String'})

TSDC-7190 12.5.0 Google Analytics connector does not support Google Analytics 4

During 2023, Google will retire the legacy version of Google Analytics, called
Universal Analytics. Instead, the newer version, Google Analytics 4 (GA4), is going to
be the only option.

To learn more, see the official communication from Google.

The Spotfire data connector for Google Analytics currently only supports accessing
data from Universal Analytics, and not from GA4. This means that when you migrate
from Universal Analytics to GA4 in Google Analytics, you can no longer use the
Google Analytics connector to access your data in Spotfire.

Workaround: Access Google Analytics 4 data via Google BigQuery

If you have access to Google BigQuery, you can export your GA4 data to Google
BigQuery. Then you can access your GA4 data in Spotfire by using the connector for
Google BigQuery.

To learn how to export your GA4 data, see BigQuery Export.

Tip: Google Analytics data contains repeated columns. When you access Google
Analytics data with the Google BigQuery connector, make sure you select Enable
repeated columns when you create the connection, to be able to view all columns.
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Installation

The following are instructions on how to install version 12.5 of TIBCO Spotfire® Analyst.

The TIBCO Spotfire® Analyst client is delivered as two different installers. The installer labelled
"single_user" is the default one. Use this if you do not know which version to select. The installer
labelled "single_user" installs the product for the logged in user only. The other users on the same
machine will not be able to use the client. The installer labelled "shared_computer" installs the product
for all users on the machine. This installer requires administrative privileges on the machine.

Installation of Release 12.5

1. First install/upgrade the TIBCO Spotfire® Server to version 12.5.
2. Deploy the TIBCO Spotfire® 12.5 distribution on the TIBCO Spotfire® Server 12.5.
3. Finally, install TIBCO Spotfire® Analyst 12.5 on all client computers.

Installation Notes

o If the NET 4.8 framework is not installed, it will be downloaded and installed when launching the
"shared_computer" TIBCO Spotfire® Analyst client installer. The "single_user" installer will not
download the .NET framework, because it does not have system changing privileges. However, it
will complain if the .NET framework is missing.

o If the product localization is defined as a user group preference, a client restart is required after
the initial login to the server for the changes to be fully applied. Note that clients are not informed
that such a restart is required. It is also important that the appropriate localization packages are
deployed to the TIBCO Spotfire® Server prior to setting the user group preference.

Note that the correct language pack and the matching server preference must be set on the very first
server that the user connects to. Changing the settings on the Server will not have any effect. If the
localization group preference does not have any effect, it can be enforced on clients using Tools >
Options.

TIBCO Spotfire® Analyst Release Notes
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Migration and Compatibility

The following are instructions on how to migrate from a previous release to version 12.5 of TIBCO
Spotfire® Analyst.

Upgrading from Previous Version without Installing

1. First install/upgrade the TIBCO Spotfire® Server to version 12.5.
2. Deploy the TIBCO Spotfire® 12.5 distribution on the TIBCO Spotfire® Server 12.5.

3. Start the old version of TIBCO Spotfire® Analyst, log on to the TIBCO Spotfire® Server 12.5 and
accept the update.

With Spotfire 10.3, a trust mechanism for data functions was introduced. Also, the trust stamp
was changed to be calculated with SHA-512. Therefore, when updating from an older version to
10.3 or later, the trust stamps in all Spotfire analysis files in the library that include IronPython
& scripts, JavaScripts, data connection custom queries or data functions must be updated. New
server CLI commands called "find-analysis-scripts" and "trust” can be used to find and update
or automatically trust old scripts and data functions in your library. For more information, see
the TIBCO Community article: https://community.tibco.com/s/article/Script-and-Data-function-
trust-in-Spotfire-10-3-and-later.

Compatibility Versions

You can use TIBCO Spotfire 12.5 to open .dxp analysis files that were created and saved in any older
version of Spotfire that is still in support.

The compatibility versions of TIBCO Spotfire 12.5 are updated to versions 12.4 and 12.0 LTS. This
means that .dxp analysis files that you create and save in Spotfire 12.5 can be opened in versions 12.4
and 12.0 LTS of Spottire.

When you use an older version of Spotfire to open an analysis file that was created in a newer
& version of Spotfire, features from the newer version might not be available, and the analysis
might look and behave differently compared to the version in which it was created.

Version Compatibility versions

12.5 12.4,12.0 LTS

12.4 12.3,12.0 LTS

12.3 12.2,12.0 LTS

12.2 12.1,12.0 LTS

12.1 12.0LTS, 11.4 LTS
12.0 LTS 11.8,11.4 LTS

11.8 11.7,11.4 LTS

11.7 11.6, 114 LTS

11.6 11.5,114 LTS
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11.5 11.4 LTS, 10.10 LTS
114 LTS 11.3,10.10 LTS
10.10 LTS 10.9, 10.3 LTS

File compatibility example

For example, when you create a . dxp analysis file in Spotfire 12.3, the file is saved with
compatibility versions for 12.2 and 12.0 LTS. You can open the . dxp file in any older Spotfire
version that either is one of those versions, or has 12.2 or 12.0 LTS as compatibility versions.

That means you can open the . dxp analysis file that you saved in Spotfire 12.3 in the following
older versions: 12.2, 12.1, and 12.0 LTS.

Newer and older versions of Spotfire Analyst client can be used to connect to the current version of
Spottire Server in order to upgrade or downgrade the client packages. However, it is recommended
to always run the same version of client and server in production environments. See System
Requirements.
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TIBCO Documentation and Support Services

For information about the Spotfire products, you can read the documentation, contact TIBCO Support,
and join the TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly
in HTML and PDF formats.

The website is updated frequently and is more current than any other documentation included with the
product.

TIBCO Spotfire Documentation

The documentation for all Spotfire products is available on the TIBCO Spotfire® Documentation page.
This page takes you directly to the latest version of each document.

To see documents for a specific Spotfire product or version, click the link of the product under 'Other
versions', and on the product page, choose your version from the top right selector.

Release Version Support

Some release versions of TIBCO Spotfire products are designated as long-term support (LTS) versions.

LTS versions are typically supported for up to 36 months from release. Defect corrections will typically
be delivered in a new release version and as hotfixes or service packs to one or more LTS versions. See

also https://docs.tibco.com/pub/spotfire/general/LTS/spotfire_LTS_releases.htm.

How to Contact TIBCO Support
Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

o For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support portal at https://support.tibco.com.

» For creating a Support case, you must have a valid maintenance or support contract with TIBCO.
You also need a user name and password to log in to https://support.tibco.com. If you do not have a
user name, you can request one by clicking Register on the website.

System Requirements for Spotfire Products

For information about the system requirements for Spotfire products, visit http://spotfi.re/sr.

How to join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to
https://community.tibco.com.

For quick access to TIBCO Spotfire content, see https://community.tibco.com/products/spotfire.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY
(OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE

FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END
USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE "LICENSE" FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of Cloud Software Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, TIBCO Spotfire, TIBCO Spotfire Analyst, TIBCO Spotfire
Automation Services, TIBCO Spotfire Server, TIBCO Spotfire Web Player, TIBCO Enterprise Runtime
for R, TIBCO Enterprise Runtime for R - Server Edition, TERR, TERR Server Edition, and TIBCO
Spotfire Statistics Services are either registered trademarks or trademarks of Cloud Software Group,
Inc. in the United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme.txt file for the
availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. CLOUD
SOFTWARE GROUP, INC MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S)
AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY
OR INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of Cloud Software Group, Inc. may be covered by registered patents. Please
refer to TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 1994-2023 Cloud Software Group, Inc. All Rights Reserved.
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